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About This Book

Purpose

This book describes how to install Novell® Integration Manager™.

Audience

This book is for users and/or administrators responsible for installing and configuring the Novell 
Integration Manager for both development and production environments.
7
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1 Preparing to Install Integration Manager

This Chapter provides an overview of the Novell Integration Manager installation program. The 
installation program is self-documenting, but there are some decisions you need to make before you run 
the install. This chapter helps you make them.

Topics include:

About the installation program
Starting the install
What gets installed
Installing in console mode
Uninstalling Integration Manager
Contacting Technical Support

Latest information For the latest information on hardware and software requirements, supported 
databases, and specific install issues, see the Release Notes.

About the installation program
The installation program is an Install Anywhere wizard that is similar on all platforms. There are three 
options for installing Novell Integration Manager:

System Requirements
See the Integration Manager release notes for the latest system requirements.

Option Description Platform

Default Installs the Integration Manager Designer

Installs the Integration Manager runtime engine 
(the Integration Manager Enterprise Server)

Windows, 
Linux

Designer Installs the Integration Manager Designer only Windows, 
Linux

Runtime Installs the Integration Manager Enterprise Server 
only

Windows, 
Solaris, Linux

Custom Lets you select options to install a specific 
configuration of products and features

Windows, 
UNIX, Linux
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Starting the install
When you’re ready to install Integration Manager, read this section to learn about starting the Integration 
Manager installation program on your platform. You can get the installation program from the exteNd 
product CD or by downloading one of the following files from the Novell Web site:

After you download one of these archives, extract its contents to your file system. Then you can start the 
install:

What gets installed
This section lists what gets installed or started during the installation:

Files
Startup items

If you uninstall manually, you need to make sure these are deleted or stopped.

Files
The installation program installs into the directory of your choice. The default depends on your platform:

Startup items
In Windows, the Novell Integration Manager install creates the following program group on the Start 
menu:

Novell Integration Manager

Platform File to download

Windows NIM.exe

Solaris NIM.bin

Linux NIM.bin

Platform How to start the Integration Manager install

Windows 1 Find the file NIM.exe on the product CD or, if you downloaded 
the installation program, on your file system.

2 Run this executable file.

Linux 1 In a terminal window, navigate to the file NIM.bin on the 
product CD or, if you downloaded the installation program, on 
your file system.

2 Type:
sh NIM.bin

Platform Default install directory

Windows C:\Novell\NIM6

Linux /opt/novell/nim6
10   Novell Integration Manager Installation Guide



Installing in console mode
If you’ve decided to run the installation program in console (text-based) mode, read this section to learn 
how.

To run the installation program in console mode:

1 At the command prompt, start the installation program with the -i console switch. Here’s the syntax 
for both UNIX and Linux:

sh installer-filename -i console

For example:
sh NIM.bin -i console

During the installation program, the following commands are available (at just about any time) to 
let you control its operation:

2 Follow the prompts as they display on the console. The installation program displays the Choose 
Product Features prompt, including a list of the current feature selections:
Choose Product Features
-----------------------

ENTER A COMMA_SEPARATED LIST OF NUMBERS REPRESENTING THE FEATURES YOU WOULD 
LIKE TO SELECT, OR DESELECT. TO VIEW A FEATURE'S DESCRIPTION, ENTER 
'?<NUMBER>'.  PRESS <RETURN> WHEN YOU ARE DONE:

    1- [X] Default
    2-  |-[X] Runtime Engine
    3-  |-[X] Designer

Please choose the Features to be installed by this installer.
   : 

This section provides some tips for completing this part of the install in console mode.

What the symbols mean Here’s a key to the Choose Product Features list:

Type this command If you want to

back Go back to the previous prompt (to change your 
response or just review it)

quit Cancel the install

Symbol Meaning

[X] The feature is selected and will be installed.

[ ] The feature is deselected and will not be installed.

[-] The feature is partially selected. You see this symbol for a parent item 
when one or more of its children are deselected. It indicates that a 
subset of the feature will be installed.

IMPORTANT:  If you deselect all of a parent item’s children but leave 
the parent item partially selected, some files related to that parent item 
may get installed. If this is not what you want, be sure to deselect the 
parent item too.
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How to select and deselect The Choose Product Features prompt works by toggling any item(s) 
you specify:

You can toggle multiple items at a time by typing the appropriate item numbers in a comma-separated 
list. For example:

8,15,22

Toggling a parent item sets all of its children to the same state.

How to review your selections After you respond to the Choose Product Features prompt, you can 
review your selections by typing the back command. You can then make further changes or continue on 
to the next install prompt.

Uninstalling Integration Manager
If you need to remove an existing Novell Integration Manager installation, you can run the Integration 
Manager uninstall program. To start the uninstall program, use one of the following approaches 
(depending on your platform).

IMPORTANT:  Before you uninstall (by using the uninstall program or manually), make sure you shut 
down all Novell Integration Manager programs and utilities.

The uninstall program won’t remove files that were created or changed after Integration Manager was 
installed. You can examine the remaining files to decide if there are any (as described in “Files” on 
page 10) that you want to keep. You can remove the other files and folders yourself.

Uninstalling manually As an alternative to using the uninstall program, you can manually remove the 
files and other artifacts of an Integration Manager Installation.

See the section on “What gets installed” on page 10 for a list of files and other artifacts to remove.

If you Then

Type the number of a selected or 
partially selected item:

8

That item will be deselected

Type the number of a deselected item:
22

That item will be selected

Platform How to run the uninstall program

Windows 1 Navigate to the \NIM6\Uninstall_Novell Integration Manager folder.

2 Double-click Uninstall Novell Integration Manager.exe.

1 Go to the Windows Control Panel and select Add or Remove 
Programs.

2 Select Novell Integration Manager, then click the 
Change/Remove button.

Windows, 
UNIX, 
Linux

1 In a terminal window, navigate to the 
/novell/nim/Uninstall_Novell Integration Manager directory.

2 Type “sh Uninstall_Novell_Integration_Manager”.
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Contacting Technical Support
To learn about the online product support available to you, visit the Novell Integration Manager Web site 
(http://www.novell.com/products/integrationmanager).

If you contact the Novell Integration Manager support staff for assistance, you will be asked to provide 
the following:

Information about your environment
Information about your problem

Information about your environment

Information about your problem
Does the problem occur in the development environment or at runtime?
What was the specific action that caused the error? 
What error message did you see? 
Can the problem be recreated consistently?
What are the exact steps to recreate the error? Please be prepared to provide an example

Category Details

Product versions Available from the About... help menu

Operating system The platform for your server

Database platform The DBMS you are using for application deployment 
and application data, including versions

Database drivers The types and versions of the database drivers you 
are using

Browser The name and version number of the Web browser 
that you are using

Java Virtual Machine 
version (JVM)

The version of the JVM that you are using

Proxy servers and firewalls Whether you are using a proxy server or firewall in 
your system configuration
Preparing to Install Integration Manager Blart 13
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2 Installing Integration Manager

This section presents an overview the Integration Manager installation options. These options allow you 
to quickly install the Integration Manager design and runtime components. Topics include:

About the Installation Process
Running the Installation Program
Installing JCE Jurisdiction Policy Files
Creating Access Control Files for JBoss

About the Installation Process
The Novell Integration Manager installation program allows you to install the Integration Manager 
design components, runtime components, or both. You can use the installation program to install the 
runtime components to the JBoss application server. To install the runtime components to other 
application servers, see “Manually Deploying the Integration Manager Enterprise Server” on page 19.

Running the Installation Program
To install Novell Integration Manager:

1 Exit all other programs (if running on Windows), then launch the Novell Integration Manager 
installation program as described in “Starting the install” on page 10.
The License Agreement panel displays:
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2 To continue with the install, you must select the accept the license agreement button, then click 
Next. The Introduction screen is displayed. 

3 Click Next. The Choose Install Set screen is displayed:

You can choose to install the Integration Manager Designer, the Integration Manager Enterprise 
Server, or both. The default is to install both. To install the Integration Manager Enterprise Server, 
you must have a JBoss application server Version 4.0.3 or higher installed. JBoss does not have to 
be running before you install the runtime engine.

4 Select Designer, Runtime Engine, or both, then click Next. 
The installation program displays Choose Install Folder screen, which asks you to specify where 
you would like to have Integration Manager installed. The default installation location is 
c:\Novell\NIM6 (Windows) or /opt/novell/nim (Linux). 

5 Specify the a directory in which to install Integration Manager, then click Next. 
If you selected the runtime engine as part of the install set, the installation program displays the 
JBoss Configuration screen, which asks you to specify the location of your JBoss application server 
installation:
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NOTE:  The Integration Manager installation program only installs the Integration Manager 
Enterprise Server to the JBoss application server. To install the Integration Manager Enterprise 
Server to other application servers, see “Manually Deploying the Integration Manager Enterprise 
Server” on page 19.

6 Specify the JBoss installation directory.
7 If you are installing the Integration Manager engine into a JBoss cluster, select the all option. 

Otherwise, select default. 
Your choice specifies which JBoss server configuration will be copied for use with the Integration 
Manager Enterprise server. If you select all, the installation program copies the JBoss server all 
directory, renames the copy NIM, then installs the Integration Manager Enterprise Server into the 
NIM directory. Use this option if you are clustering your JBoss servers. If you select default, the 
installation program copies the JBoss server default directory, renames the copy NIM, then installs 
the Integration Manager Enterprise Server into the NIM directory.

8 After you have specified the JBoss configuration options, click Next. The Pre-installation 
Summary screen is displayed.

9 Click Install. The Novell Integration Manager installation program installs Integration Manager 
using the options that you specified.
After the installation completes, you should start Integration Manager and set your preferences for 
the various external editors (for example, browser, XML editor, JSP editor, XSL editor) by 
selecting Tools > Preferences > General and Tools > Preferences > Editor.

Creating Access Control Files for JBoss
After installing the Installation Manager runtime to JBoss, you must create the following access control 
files in the {jboss server root}\server\nim\conf directory:

roles.properties
users.properties 

You use the roles.properties file to map one or more user names of your choosing to the role 
ComposerAdministrators, which is required by Novell Integration Manager. You use users.properties to 
map a password to the user or users specified in roles.properties. 

To create access control files for JBoss:

1 Use a text editor to create a file named roles.properties, with the following contents (if 
roles.properties already exists, add the following to the file):
username=ComposerAdministrators
where username is any user name of your choosing

2 Save the roles.properties file in the {jboss server root}\server\nim\conf directory.
3 Use a text editor to create a file named users.properties, with the following contents (if 

users.properties already exists, add the following to the file):
username=password
where username is the username specified in roles.properties, and password is the password that 
you want to assign to that user. Repeat this step for each user specified in roles.properties.

4 Save the users.properties file in the {jboss server root}\server\nim\conf directory.
Installing Integration Manager 17



Installing JCE Jurisdiction Policy Files
Due to import control restrictions of some countries, the jurisdiction policy files shipped with Novell 
Integration Manager allow strong but limited cryptography. An unlimited strength version of these files 
is available for those living in eligible countries (which is most countries). 

NOTE:  This step is particularly important if you are upgrading from previous versions of exteNd 
Composer. Without the unlimited strength JCE Jurisdiction Policy files, when working with projects created 
with previous versions of exteNd Composer, you will receive the error message "error decrypting 
password" on any object that contains a password field (for example, connection resources, WS 
Interchange actions). 

To install JCE unlimited JCE Jurisdiction Policy files:

1 Download the JCE "Unlimited Strength" Jurisdiction Policy Files from 
http://java.sun.com/products/jce/index-14.html#UnlimitedDownload. The policy files are 
contained in a zip archive file.

2 Uncompress and extract the downloaded file to a temporary directory. This creates a subdirectory 
named "jce". This directory contains the following files:
README.txt
COPYRIGHT.html
local_policy.jar
US_export_policy.jar

3 Copy the local_policy.jar and US_export_policy.jar files to the \nim\Common\jre\lib\security 
directory. 
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3 Manually Deploying the Integration Manager 
Enterprise Server 

The Integration Manager installation program provides automated installation of the Integration 
Manager Enterprise Server (also know as the Integration Manager runtime) to JBoss application servers. 
To deploy Integration Manager applications to other supported application servers, you must manually 
install the Integration Manager Enterprise Server. The following sections provide instructions for 
manually installing the Integration Manager Enterprise Server to supported application servers. 

Runtime Files
To install the Integration Manager Enterprise Server to a supported application server, you need the 
Integration Manager runtime files, which are included in the Server Resources directory within the NIM6 
(Windows) or nim (Linux) installation directory. The Server Resources directory contains the following 
sub-directories:

\conf

\deploy

\lib

\Tomcat

The files in these directories are used in the procedures that follow.

JBoss
The Integration Manager installation program provides automated installation of the Integration 
Manager Enterprise Server (also know as the Integration Manager runtime) to JBoss application servers. 
You can install the Integration Manager Enterprise server to a JBoss application server at any time by 
running the Integration Manager installation program. If for any reason you need to install the Integration 
Manager Enterprise server to JBoss Version 4 manually, follow these steps: 

NOTE:  Note: The steps to manually deploy the Integration Manager Enterprise Server from versions of 
Integration Manager before version 5.2.1 are different. Contact Novell Customer Support for instructions. 

1 Copy the contents of the Runtime Files conf directory (see “Runtime Files” on page 19) to the 
{JBoss install directory}\server\{server configuration directory}\conf directory. 
NOTE:  The JBoss server default directory is set as the server configuration directory in the 
supplied files. If you want to use a different JBoss server configuration, you will have to modify the 
xconfig.xml located in the \server\{server configuration directory}\conf directory. Locate the line 
<XC_DIR Desc="Location of eXtendComposer Installation">../server/default/deploy</XC_DIR> in 
the xconfig.xml file, and change "default" to the name of the server configuration directory that you 
want to use.

2 Copy the contents of the Runtime Files deploy directory (see “Runtime Files” on page 19) to the 
{JBoss install directory}\server\{server configuration directory}\deploy directory. 

3 Copy the contents of the Runtime Files lib directory (see “Runtime Files” on page 19) to the 
{JBoss install directory}\server\{server configuration directory}\lib directory. 

4 Following the instructions given in “Creating Access Control Files for JBoss” on page 17, create a 
text file named users.properties in the {JBoss install directory}\server\{server configuration 
directory}\conf directory.
Manually Deploying the Integration Manager Enterprise Server 19



5 Following the instructions given in “Creating Access Control Files for JBoss” on page 17, create a 
text file named roles.properties in the {jboss install directory}\server\{server configuration 
directory}\conf directory.

6 Start JBoss. 
You can now start the Integration Manager Enterprise Server using the URL 
"http://localhost:8080/exteNdComposer". Use the user ID and password that you specified when 
you created the users.properties and roles.properties files. 

WebLogic 8.1.1
Follow these steps to manually deploy the Integration Manager Enterprise Server to WebLogic 8.1.1.

1 Create a directory named Composer in the weblogic81 directory.
2 Create the following subdirectories in the Composer directory:

bin
console
lib
log
tmp

3 Copy the contents of the Runtime Files lib directory (see “Runtime Files” on page 19) to the 
weblogic81\Composer\lib directory.

4 Move the exteNdComposer.ear file from the weblogic81\Composer\lib directory to the 
weblogic81\Composer\console directory.

5 Copy the xconfig.xml file from the Runtime Files conf directory (see “Runtime Files” on page 19) 
to the weblogic81\Composer\lib directory.

6 Edit the xconfig.xml file in the weblogic81\Composer\lib directory and make the following 
changes:
6a Locate the XC_DIR element (near the beginning of the xconfig.xml file) and change the path 

contained in this element from "../server/default/deploy" to the path to the Composer directory 
that you created in step 1 (for example, D:\bea\weblogic81\Composer).

6b Locate the FRAMEWORKFACTORY element and replace it with the following:
<FRAMEWORKFACTORY Desc="Class name that is used to resolve resource 
references">com.sssw.b2b.xs.weblogic.GXSWL60FrameworkFactory</FRAMEWORKFACTORY
>

6c Locate the JBOSS_40 element and replace the JBoss element and its contents with the 
following:
<WEBLOGIC_600>
      <ADMIN_HOST>Your_Host_Name_or_IP</ADMIN_HOST>
      <ADMIN_PORT>7001</ADMIN_PORT>
      
<HELPER_CLASS>com.sssw.b2b.xs.deploy2.wl70.GXSWL70DeployHelper</HELPER_CLASS>
      <WEBLOGIC_HOME>D:\bea\weblogic81</WEBLOGIC_HOME>
      <STAGING_LOCATION>D:\bea\weblogic81\Composer\tmp</STAGING_LOCATION>
      <DEPLOY_INPUT>deploy/wl60/DeployInput.jsp</DEPLOY_INPUT>
      <DEPLOY_HANDLER>Composer.wl60.DeployHandler</DEPLOY_HANDLER>
   </WEBLOGIC_600>

NOTE:  Change the host name contained in the ADMIN_HOST element to match your 
environment. Change the paths contained in the WEBLOGIC_HOME and 
STAGING_LOCATION elements to match the paths in your environment.

7 Edit the startWebLogic.cmd file in the directory for your domain (for example, 
\weblogic81\user_projects\domains\{your domain}, and make the following additions: 
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7a Before the set CLASSPATH statement, add a variable called XCSCLASSPATH, and assign 
to the variable the path to the xcs-all.jar file in the Composer lib directory. For example:
set XCS_CLASSPATH=D:\bea\weblogic81\Composer\lib\xcs-
all.jar;D:\bea\weblogic81\Composer\lib\;

7b Add the XCSCLASSPATH variable to the CLASSPATH variable. For example (additions 
that you must add to the supplied files are shown in bold):
set 
CLASSPATH=%XCS_CLASSPATH%;%WEBLOGIC_CLASSPATH%;%POINTBASE_CLASSPATH%;%JAVA_HOM
E%\jre\lib\rt.jar;%WL_HOME%\server\lib\webservices.jar;%CLASSPATH%

8 Edit the fileRealm.properties file in the {install path}\bea81\user_projects\domains\{your 
domain} directory and add the line group.ComposerAdministrators=system to the file.

9 Start the WebLogic application server. 
10 Using the WebLogic Administration console, select Security | Realms | {your realm} | Groups. 

10a Click on the Configure New Group link. 
10b Create a Group named ComposerAdministrators. 
10c Select the Membership tab. 
10d Assign the ComposerAdministrators group to the Administrators group.

11 Using the WebLogic Administration console, select Security > Realms > {your realm} > Users. 
11a Select the User name of the Composer Administrator. 
11b Select the Groups tab. 
11c Assign the user to the group ComposerAdministrators. 

12 Using the WebLogic Administration console, select {your domain} | Servers | Deployments | 
Applications. 
12a Select the Deploy a New Application link in the right frame of the WebLogic Administration 

console window. 
12b Using the Location links, navigate to the \weblogic81\Composer\console directory, select the 

exteNdComposer.ear file, then select Continue. 
12c Select Deploy. 

You can now start the Integration Manager Enterprise Server using the URL 
"http://localhost:7001/exteNdComposer". Use the user name and password of the user that you 
assigned to the ComposerAdministrator role. 

WebSphere 5
Follow these steps to manually deploy the Integration Manager Enterprise Server to WebSphere 5.

1 In the \WebSphere\AppServer directory, create the following directory structure: 
Composer

bin 
console 
lib 
log 
tmp

2 Copy the updateLicense.bat and updateLicense.sh files from the Runtime Files conf directory 
(see “Runtime Files” on page 19) to the \WebSphere\AppServer\Composer\bin directory.

3 Copy the contents of the lib directory from the Runtime Files lib directory (see “Runtime Files” on 
page 19) to the \WebSphere\AppServer\Composer\lib directory. 

4 Move the exteNdComposer.ear file from the \WebSphere\AppServer\Composer\lib directory to 
the \WebSphere\AppServer\Composer\console directory.
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5 Copy the xconfig.xml file from the Runtime Files conf directory (see “Runtime Files” on page 19) 
to the \WebSphere\AppServer\Composer\lib directory.

6 Edit the xconfig.xml file in the \WebSphere\AppServer\Composer\lib directory and make the 
following changes:
6a Locate the XC_DIR element (near the beginning of the xconfig.xml file) and change the path 

contained in this element from "../server/default/deploy" to the path to the Composer directory 
that you created in step 1 (for example, D:\WebSphere\AppServer\Composer).

6b Locate the FRAMEWORKFACTORY element and replace it with the following:
<FRAMEWORKFACTORY Desc="Class name that is used to resolve resource 
references">com.sssw.b2b.xs.websphere.GXSWS40FrameworkFactory</FRAMEWORKFACTOR
Y>

6c Locate the JBOSS_40 element and replace the JBoss element and its contents with the 
following:
<WEBSPHERE_40>
      <ADMIN_HOST>Your_Server_Name_or_IP</ADMIN_HOST>
      <ADMIN_PORT>2809</ADMIN_PORT>
      <STAGING_LOCATION>D:\WebSphere\AppServer\Composer\tmp</STAGING_LOCATION>
      <DEPLOY_INPUT>deploy/ws50/DeployInput.jsp</DEPLOY_INPUT>
      <DEPLOY_HANDLER>Composer.ws50.DeployHandler</DEPLOY_HANDLER>
   </WEBSPHERE_40>

NOTE:  Change the host name or IP address contained in the ADMIN_HOST element to 
match your environment. Change the path contained in the STAGING_LOCATION element to 
match the paths in your environment.

7 Start the WebSphere Application Server. 
8 Start the WebSphere Administrative Console. 
9 Select Environment > Manage WebSphere Variables. 
10 Create a new variable with the following values: 

Name: EXTEND_COMPOSER_HOME 
Value: $(WAS_INSTALL_ROOT)/Composer 
Description: The root directory for the Integration Manager installation.

11 Create another new variable, with the following values: 
12 Name: EXTEND_COMPOSER_LIB 

Value: ${EXTEND_COMPOSER_HOME}/lib 
Description: The Integration Manager directory where the system Jars can be located.

13 Select Servers > Application Servers, then select the name of the application server to which you 
want to install the Integration Manager Enterprise Server. The Administrative Console displays the 
configuration page for the application server. 

14 Select Process Definition. 
15 Select Java Virtual Machine from the Additional Properties list. 
16 Select Custom Properties from the Additional Properties list. 
17 Create a new custom property, with the following values: 

Name: ws.ext.dirs 
Value: ${EXTEND_COMPOSER_LIB} 
Description: The Integration Manager extension directory

18 Select Applications > Enterprise Applications. 
19 Select Install. 
20 Select the exteNdComposer.ear file in the {WebSphere install 

directory}\AppServer\Composer\console directory. 
21 Accept the default settings for bindings. 
22 Accept the default settings for AppDeployment Options. 
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23 Select the appropriate options for mapping virtual hosts to web modules, and mapping modules to 
application servers. 

24 Map the ComposerAdministrators security role to the appropriate users and groups. 
25 Select Finish to complete the installation. 
26 Save the changes to the application server master configuration. 
27 Stop and restart the application server before attempting to start the Integration Manager Enterprise 

Server.
You can now start the Integration Manager Enterprise Server using the URL 
"http://localhost:9080/exteNdComposer". 
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exteNd Application Server 5.2
Follow these steps to manually deploy the Integration Manager Enterprise Server to the exteNd 
Application Server Version 5.2.

1 In the \exteNd5\AppServer directory, create the following directory structure: 
Composer

bin 
console 
lib 
log 
tmp

2 Copy the contents of the lib directory from the Runtime Files lib directory (see “Runtime Files” on 
page 19) to the \exteNd5\AppServer\Composer\lib directory.

3 Move the exteNdComposer.ear file from the \exteNd5\AppServer\lib directory to the 
\exteNd5\AppServer\Composer\console directory.

4 Copy the xconfig.xml file from the Runtime Files conf directory (see “Runtime Files” on page 19) 
to the \exteNd5\AppServer\Composer\lib directory.

5 Edit the xconfig.xml file in the \exteNd5\AppServer\Composer\lib directory and make the 
following changes:
5a Locate the XC_DIR element (near the beginning of the xconfig.xml file) and change the path 

contained in this element from "../server/default/deploy" to the path to the Composer directory 
that you created in step 1 (for example, D:\exteNd5\AppServer\Composer).

5b Locate the FRAMEWORKFACTORY element and replace it with the following:
<FRAMEWORKFACTORY Desc="Class name that is used to resolve resource 
references">com.sssw.b2b.xs.sssw.GXSS3FrameworkFactory</FRAMEWORKFACTORY>

5c Locate the JBOSS_40 element and replace the JBoss element and its contents with the 
following:
    <NOVL>
      <BIN_DIR>.</BIN_DIR>
      <DEPLOY_INPUT>deploy/novl/DeployInput.jsp</DEPLOY_INPUT>
      <DEPLOY_HANDLER>Composer.novl.DeployHandler</DEPLOY_HANDLER>
    </NOVL>

6 Copy the following code into a text file, and save the file in the 
\exteNd5\AppServer\Composer\console directory, using the name 
exteNdComposerEARDeplPlan.xml: 
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<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE earJarOptions PUBLIC "-//SilverStream Software, Inc.//DTD J2EE EAR 
Deployment Plan 1.3//EN" "deploy-ear_1_3.dtd">

<earJarOptions isObject="true">
<earJar isObject="true">

<version type="String">1.0</version>
<earJarName type="String">extendComposer.ear</earJarName>
<moduleList isObject="true">

<module isObject="true">
<warJar isObject="true">

<warJarName type="String">exteNdComposer.war</warJarName>
<isEnabled type="Boolean">True</isEnabled>
<deployToFilesystem>False</deployToFilesystem>
<urls type="StringArray">

<el>exteNdComposer</el>
</urls>
<deployedObject 

type="String">exteNdComposer</deployedObject>
<excludedJSPs type="StringArray">

<el>deploy/wl60/DeployInput.jsp</el>
<el>deploy/wl60/DeployInput-page2.jsp</el>
<el>deploy/wl60/DeployInput-page3.jsp</el>
<el>deploy/wl60/DeployInput-validate-page2.jsp</el>
<el>deploy/wl60/DeployInput-validate.jsp</el>
<el>deploy/ws40/DeployInput.jsp</el>
<el>deploy/ws40/DeployInput-page2.jsp</el>
<el>deploy/ws40/DeployInput-page2-validate.jsp</el>
<el>deploy/ws40/DeployInput-page3.jsp</el>
<el>deploy/ws40/DeployInput-validate.jsp</el>

</excludedJSPs>
<roleMap isObject="true">

<roleMapping isObject="true">
<name type="String">ComposerAdministrators</name>
<userOrGroupName 

type="String">ComposerAdministrators</userOrGroupName>
</roleMapping>

</roleMap>
</warJar>

</module>
</moduleList>
<roleMap isObject="true">

<roleMapping isObject="true">
<name type="String">ComposerAdministrators</name>
<userOrGroupName 

type="String">ComposerAdministrators</userOrGroupName>
</roleMapping>

</roleMap>
</earJar>

</earJarOptions>

7 Locate the AgJars.conf file in the \exteNd5\AppServer\bin directory and open the file in a text 
editor. 

8 Add the following lines to the "MODULE COMMON" section, near the end of the file: 
        $SS_LIB ../Composer/lib/xcs-all.jar 
        $SS_LIB ../Composer/lib/xcs-ejb-res-stub.jar 
        $SS_LIB ../Composer/lib/
        $SS_LIB ../Composer/lib/commons-codec-1.3.jar
        $SS_LIB ../Composer/lib/IDMLogging.jar
        $SS_LIB ../Composer/lib/jaxrpc-api.jar
        $SS_LIB ../Composer/lib/saaj-api.jar
        $SS_LIB ../Composer/lib/xpp3.jar
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NOTE:  You may need to add other JARs, depending on the Integration Manager Connects that 
you are using (for example, $SS_LIB ../Composer/lib/xc-iway.jar, $SS_LIB 
../Composer/lib/iwpsci.jar). See your Integration Manager Connect documentation for the JARs 
needed for a specific Integration Manager Connect. 

9 Start the application server. 
10 From a command prompt, navigate to the \exteNd5\AppServer\bin directory. 
11 Type the following command at the command prompt (replacing the information in brackets with 

the information that is appropriate for your environment): 
silvercmd deployEAR {server name}:{http port number 80} SilverMaster50 {server 
install path}\AppServer\Composer\console\exteNdComposer.ear -f {server install 
path}\AppServer\Composer\console\exteNdComposerEARDeplPlan.xml -U {admin} -P 
{admin password}. 

For example, if your server is named "myserver", is set up to use port 80 for http (this is the default 
setting), you have installed the application server in the default location, and the administrator is 
named “admin” with the password “admin”, you would type: 

silvercmd deployEAR myserver:80 SilverMaster50 C:\Program 
Files\Novell\exteNd5\AppServer\Composer\console\exteNdComposer.ear -f  
C:\Program 
Files\Novell\exteNd5\AppServer\Composer\console\exteNdComposerEARDeplPlan.xml 
-U admin -P admin.

This command deploys the Integration Manager Enterprise Server to the application server. The 
next step is to add a security group and role for the Integration Manager Enterprise Server to the 
application server. 

12 Start the exteNd application server Server Management Console. 
13 Select View > Security. 
14 Select Users & Groups. 
15 Double-click Silver Security. 
16 Double-click Groups. 
17 Add a new group named ComposerAdministrators. 
18 Click on ComposerAdministrators, then select the Add User to Group button from the buttons 

on the bottom of the page (hold the mouse pointer over a button to display a tool tip that gives the 
button name). 

19 In the Add Users to Group dialog box, double-click SilverSecurity, then Users. 
20 Click on the name of the user that you want to add to the ComposerAdministrators group, then 

select Add. 
21 Select Close. 
22 Select File > Restart Server.

After the application server has restarted, you can start the Integration Manager Enterprise Server 
using the URL "http://localhost:{port number}/exteNdComposer". The default port number is 80.

Apache Tomcat 4
Follow these steps to manually deploy the Integration Manager Enterprise Server to the Apache Tomcat 
application server.

1 Make sure that the Tomcat application server is not running. 
2 In the Tomcat directory, create the following directory structure: 

Composer
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bin 
console 
lib 
log 
tmp

3 Copy the contents of the lib directory from the Runtime Files lib directory (see “Runtime Files” on 
page 19) to the {Tomcat install directory}\Composer\lib and the {Tomcat install 
directory}\shared\lib directories. 

4 Copy the jca10apis.jar file from the Runtime Files Tomcat directory (see “Runtime Files” on 
page 19) to the {Tomcat install directory}\Composer\lib and the {Tomcat install 
directory}\shared\lib directories. 

5 Use an archive tool (for example, WinZip, File Roller) to extract the exteNdComposer.war file 
from the exteNdComposer.ear file, and place one copy of the exteNdComposer.war file in the 
{Tomcat install directory}\Composer\console directory, and another copy in the {Tomcat install 
directory}\webapps directory. 

6 Copy the xconfig.xml file from the Runtime Files conf directory (see “Runtime Files” on page 19) 
to the {Tomcat install directory}\Composer\lib directory.

7 Edit the xconfig.xml file in the {Tomcat install directory}\Composer\lib directory and make the 
following changes:
7a Locate the XC_DIR element (near the beginning of the xconfig.xml file) and change the path 

contained in this element from "../server/default/deploy" to the path to the Composer directory 
that you created in step 1 (for example, D:\Tomcat 4.1.24\Composer).

7b Locate the FRAMEWORKFACTORY element and replace it with the following:
<FRAMEWORKFACTORY Desc="Class name that is used to resolve resource 
references">com.sssw.b2b.xs.tomcat.GXSTCFrameworkFactory</FRAMEWORKFACTORY>

7c Locate the JBOSS_40 element and replace the JBoss element and its contents with the 
following:
   <TOMCAT_41>
      <ADMIN_HOST>localhost</ADMIN_HOST>
      <ADMIN_PORT>8080</ADMIN_PORT>
      <TOMCAT_HOME>D:\Tomcat 4.1.24</TOMCAT_HOME>
      <STAGING_LOCATION>D:\Tomcat 4.1.24\Composer\tmp</STAGING_LOCATION>
      <DEPLOY_INPUT>deploy/tc41/DeployInput.jsp</DEPLOY_INPUT>
      <DEPLOY_HANDLER>Composer.tc41.DeployHandler</DEPLOY_HANDLER>
   </TOMCAT_41>

NOTE:  Change the host name or IP address contained in the ADMIN_HOST element to 
match your environment. Change the paths contained in the TOMCAT_HOME and 
STAGING_LOCATION elements to match the paths in your environment.

8 Using a text editor, open the tomcat-users.xml file in the {Tomcat install directory}\conf directory, 
and add the following lines:

<user password="novell" roles="admin,manager,ComposerAdministrators" 
username="novell"/>
<role rolename="ComposerAdministrators"/>

NOTE:  Substitute any desired username and user password for “novell”.

9 Using a text editor, open the setclasspath.bat (Windows) or setclasspath.sh (Linux) file in the 
{Tomcat install directory}\bin directory, and add the path to the \Composer\lib directory to the 
CLASSPATH variable. For example, if you installed Tomcat in a directory named Tomcat 4.1.24, 
the CLASSPATH variable assignment would look like this (additions that you must add to the 
supplied files are shown in bold): 
Windows 
set CLASSPATH=%JAVA_HOME%\lib\tools.jar;D:\Tomcat 4.1.24\Composer\lib

Linux 
CLASSPATH="$JAVA_HOME"/lib/tools.jar:home/jdoe/jakarta-tomcat-4.1.24/Composer/lib
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10 From a command prompt, navigate to the {Tomcat install directory}\bin directory, and start Tomcat 
by running the startup.bat (Windows) or startup.sh (Linux\Unix) file. 

11 You can now start the Integration Manager Enterprise Server using the URL 
"http://localhost:8080/exteNdComposer". Use the user name and password of the user that you 
assigned to the ComposerAdministrator role in Step 8.
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